Web Intelligence (Webl) Objects and Business Objects InfoView

For users needing to create queries with Worcester State University data, Web-Intelligence
and Business Objects InfoView, the portal used to gain access to Web Intelligence documents
and reports, is replacing “Query Builder”, the familiar tool used with Datatel’s Colleague and
UlWeb 4.0 database software.

As stated in presentations provided to us by Kate Connolly, a Datatel Training Consultant,
“Business Intelligence refers to the applications and technologies used for gathering, storing,
analyzing, and providing access to data to help users make business decisions”.

In this instructional document | am going to include examples discussed in Kate’s training
sessions, as well as some of my own, in order to provide a basic intoductory guide for Web
Intelligence users on our campus. The URL address where SAP’s complete Web Intelligence
Rich Client User’s Guide is located is in the bibliography at the end of the document.

Web Intelligence is a web reporting tool that has been installed on the server (computer) that stores
our WSU business data. It provides an easy, interactive interface for analyzing and reporting.

Business Objects InfoView preferences only need to be setup the first time InfoView is used.
Users will be timed out after 20 minutes of inactivity and a message similar to the following
will display: “The document <Name of document> has been auto saved in the Favorites

~Weblntelligence folder. Click restore to retrieve it”. Go to the folder to locate the document.”

Worcester State University data is refreshed nightly.

Note: Use the Internet Explorer, Firefox, or Safari browsers and Do Not Use the Back or Forward

buttons to navigate in Infoview or a Web Intelligence business objects workspace.
InfoView acts as a portal for accessing Web Intelligence reports or other Business Objects.

Obijects display in a familiar folder structure similar to a Windows environment.

Explore Public Folders, Universes, and other InfoView Objects

1. Log On to Infoview (which also will be referred to as Webl—short for Web Intelligence), and expand
the Public Folders by clicking the + sign to the left of the folder name.
The only “folders” that you should see are ones to which you have been provided
access permissions.
BUSINESSOBJECTS INFOVIEW
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Web Intelligence Objects (Webl) and Business Objects InfoView

e An InfoView Universe is a set of metadata (data about data) regarding the business data being stored
(e.g. color, structure, location) in our system (e.g. Colleague/UIWeb). A Universe doesn’t contain
data. It “points” to data and makes it available through web reporting tools such as Web Intelligence.

e Users only will be able to view folders, universes, Web Intelligence documents, or other objects to
which they have been provided access permissions.

e In order to have a place to store new or modified reports, a subfolder can be created in My Favorites.

o Rather than starting a new report from scratch, an existing Web Intelligence report can be copied and
modified. It is good to keep the original reports intact and modify /customize copies, as needed.

e Public folder contents cannot be modified or deleted while residing in the Public folder.

Explore Public Folders, Universes, and other InfoView Objects
2. Under Public Folders, click the + sign to expand Datatel Sample Reports Release 1.2.
Several Universe folders (e.g. CF, FA, and ST) display.
3. In order to create a separate folder in which to store reports that you plan to use on a routine basis,

right-click the My Favorites folder and select New followed by Folder from the displayed
shortcut menu.

Enter a new folder name: CF Practice
ok]| cancal

4. In the “Enter a new folder name” box, type the name you want to assign to the new “My Favorites”
folder and click OK.

5. In order to modify an existing report rather than starting one from scratch click the CF Universe
Samples subfolder, followed by the Organize menu button, and choose Copy.

It also is possible to right-click the CF Universe Samples, choose Organize, followed by Copy.

(Once you learn how to copy existing sample reports, the same procedure can be followed to copy
ST or FA Sample Reports to your “My Favorites” folder).

In order to store copies of the CFE Sample Universe reports in a folder you created, under My
Favorites, select the CF-Practice folder (or other folder name that indicates these are “your” Webl
Reports) and choose Organize followed by Paste.

Of course, right-clicking and selecting from the shortcut menu also works.

Copies of the CF Universe Reports should be available in the subfolder you created.
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Web Intelligence Objects (Webl) and Business Objects InfoView

View an Existing Report

1. Under My Favorites, expand the CF Practice (or other) folder in which you pasted copies of the

CF Universe Sample Reports.

2. Select the GL Running Balance Report.

B[ CF - Practice

& nbox
&[0 public Folders

CF Universe Samples Copy =~ *

L

&3 Home | Document List | Open ~ | Send To - | Dashboards ~

r & | = | New ~ Add - | Organize ~ | Actions ~

= Al Title * Last Run
B [551 My Favorites !  Accepted Purchase Order Report

Question Answered: What is the total amount i
GL Account Available Balance

What is the budget for the accounts and what i
GL Running Balance Report

GL Summary Analysis Report

o

3. Right-click the Running Balance Report that was copied into you’re my Favorites (or other
chosen) folder and select View from the shortcut menu.

Be certain you are not opening the original report from the CF Universe Samples folder.
Those should be kept intact, in order to modify additional copies for new reports in

the future.
|‘— & & | New v Add v | Organize v | Actions v
E- All Title * Last
& My Favorites w|  Accepted Purchase Order Report

© [ CF - Practice

& mbox

Question Answered: What is the total amount an¢
CF Universe Sam| '  GL Account Available Balance
What is the budget for the accounts and what is t

&1 public Folders GL Running Balance Report
Properties
¥ GL Summary Analysis Repor __Categories
What money has been speml

¥ GL Transaction Detail By Dat

Updated for 1.

What type of transaction  History
ledger is it from? New

¥ Outstanding BPO GL / Projec

New for 1.1 -

|
What are the currently op ~ Organize » 2

Modify
3 Schedule

Add > |

The Sample Report opens.

If Properties is selected, a description of a report can be seen or the Name of the report

can be modified.

SAP BUSINESSOBJECTS INFOVIEW

&7 Home | Document List | Open ~ | Send To ~ | Dashboards ~

v General Properties

Properties - Total Credits for Students by Enroliment

Title: Total Credits for Students by Enrollment

D, CUDD: 44273, AZb06iZMIShAnIHEontmVu4
File Name: frs://Input/a_241/172/000/44273/~ce80c53f60b2f6216.wid

Description:  How many credit hours are registered by each student? o
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Web Intelligence Objects (Webl) and Business Objects InfoView

As it says at the top of the report screen: “This report is provided as a template and meant as a

reference for your report development. This report’s fitness for use may vary depending on
your requirements and your data. Make any formatting and design changes as needed and

verify the report logic and output in your environment before use.”

Keep in mind that reports vary. The example below will demonstrate how some basic modifications
to an existing sample report can be accomplished. This makes it easier than designing a report
from scratch. Additional modifications will be discussed in a later section of this document.

e A “Prompts” screen displays with an “Enter GL Account Number (Use % for wildcard match) 1%
prompt” highlighted. On our WSU campus, in an account that is numbered 1400232EEEQO, the 400
represents the source or grant code. The 232 represents the department code. Codes such as
EEEOQO etc. are object codes. A % or “wildcard” represents “any” value. Therefore, 1400232% would
show any value that matches 1400232 and any object codes.

View an Existing Report

4. The existing Sample Running Balance Report opens. Make certain a copy of the original

report was opened and read the information provided in green at the top of the report before

making any modifications.

 Home  Document List | Open - | Send To - | Dashbosrds -

Web Intefigence - GL Running Balance Report
+ Docernt - view | @ 13/ B i __Jo % [0 tn

Help Preferences | About | Log (|

[SAMPLE REPORT. This report is proded a5 a template and i msant as a reference for your report devslopment. This report’s ftness for
on yous requirements and your data_Make any formatting and design changes as needsd and verdy the repart logic and output in your e

I
GL Account Actuals . e i
m

Retresh Vaves 5

o) ) Reportt

5. In order to view the most recent GL Account values, click the “Refresh” button.

Data is updated every 24 hours.

[SAMPLE REPC™™ ™ : —— : e < = )
lon your requiren | Premets X

GL Account |
v

(GL Account Nus

Ryash button
<

4 110040088B02..1250111kKKk10  ~ » (&

GL Account Number > | [1%
110040088802 %

110040088805 = |
1100400EEE01

Enter GL Account Number (use % for wildcard m...

110043488802
1100434EEE01

1100434EEE08

1101311EEE0

1101312EEE01

110140088800

1101400CCC00 >
Warch 23, 2011 10:49:57 AM GNT-04:00

L &

2) More information
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Web Intelligence Objects (Webl) and Business Objects InfoView

View an Existing Report

6. On the left side of the Prompts dialog box under GL Account Number, select your department
or other desired GL account number Then, click the > symbol (Add from list of values) to
move the selected GL Account Number over to the Enter GL Account Number box (Use % for

wildcard).

If the desired GL account number isn’t visible, search for specific GL numbers by entering
the numeric criteria in the Search box and clicking the small binoculars.
Use the “wildcard” symbol (%) to represent “any” value at the location of the wildcard.

For Example: Leave the 1 (or other first GL account value) and enter the “source” and “dept.”
values followed by the “wildcard” 1200400%.

GL numbers matching the criteria display in the GL Account Number area on the left and can be
selected and moved to the right-hand “Enter GL Account Number” box for the query.

ISAMPLE REPC  Prompts x
0N YOUr TeqUIreN peply to prompts before running the query.

b4  Enter GL Account Number (use % for wildcard match): 1%

GL Account |v  Entervalue(s) for GL Account Status Fiscal Year: 2007

GL Account Nu

Refresh Values %2 Enter GL Account Number (use % for wildcard m...

GL Account Number [T‘ |1%
1562400AAA01 - —

156240088800 (<]
1562400CCC00
1562400CCC04
1562400DDD09
1562400DDD14
1562400EEE00
1562400EEE01
1562400EEE02
1562400EEEQ09 -
March 24, 2011 10:26:38 AM GWT-04,

1562400

m

Enter and Search for
. specific Department
Values Here.

2) More Information

Select or type the values you want to return to reports for each prompt displayed here

oo ]
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Web Intelligence Objects (Webl) and Business Objects InfoView

View an Existing R

eport

7. Select the “Enter values for GL Account Fiscal Year” prompt (refer to the graphic below),

refresh the

values, and choose a fiscal year on which to query.

EAMPLE REPC  Prompts X
N Your requiren peny to prompts before running the query.

(GL Account Nu

v Enter GL Account Number (use % for wildcard match): 1%
GL Account |+ O R e R

) Enter value(s) for GL Account Status Fiscal Year:

[Type values here | (—No selected value—)

Refresh Values %2 -
> Aﬂd from List of Values or from text box ]

GL Account Status Fiscal Year

Use the Add or Remove

_buttons to select and move
GL account and fiscal year
criteria until the desired
criteria is entered.

darch 24, 2011 10:26:39 AM GMT-04:00

[2008 144 -

( 7 Currently-selected values in listbox

8. Highlight any additional listed prompts and modify them, if necessary.

9. Once all prompts have been adjusted, click the Run Query button.

ISAMPLE REPC Prompts X
0N YOUr requIreén pepiy to prompts before running the query.

GL Account

GL Account Nu

v Enter GL Account Number (use % for wildcard match): 1%

v Enter value(s) for GL Account Status Fiscal Year: 2009

Enter value(s) for GL Account Status Fiscal Year:

2009

Refresh Values %3

GL Account Status Fiscal Year

March 24, 2011 10:26:39 AM GMT-04:00

2009 |44 -~

(2) Currently-selected values in listbox

™ |

The report r

uns (Continue to next page).
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Web Intelligence Objects (Webl) and Business Objects InfoView

View an Existing Report

A Document Auto save and Recovery prompt displays to inform the user that Web Intelligence
saves documents automatically when the Web Intelligence server times out (20 minutes).
It gets saved in the .pdf format, by default. If you get timed out, just Log Out and back in again.

Document Autosave and Recovery X

@ Web Intelligence saves documents automatically

when the Web Intelligence server times out
See the Working with Documents > Saving
Documents > Automatic Saving and Recovery
topic in the online help for more information

[] Don't notify me again

The completed report displays.

2400AAA01 2009 12 June, 2009 $9,846.94 $0.00 $9,846.94 $9,8
2400EEE01 2009 4 October, 2008 $12,491.00 $0.00 $12,191.00 $121
2400EEEQ9 2009 1 July, 2008 )1 47,755.54 $0.00 4 '+7,755.54 ~ 47,7
6 December, 2008 $900.00 $0.00 $:°8,655.54 $1:36
1/ January, 2009 $560.00 $0.00 $1.9,215.54 $1-9,2
8 February, 2009 $10,932.41 $0.00 $100,147.95 $10v,1

This report is in Quick Display mode.

Once a Query Report is run, the document object can be saved to your computer in an
Excel, CSV, or PDF format by clicking the Document button on the tool bar.

&% Home | Document List | Open ~ | Send To - | Dashboards ~

» Documentiv‘ vew - | E 25 &9 v E

Close
Edit
- BAMPLE REPORT: This repo
[ save Ctri+S bn your requirements and your
Save as
Save to my computer as > Excel
Save report to my computer as > PDF

csv

CSV (with options)...

The View menu provides several options for viewing the report. Quick Display mode is the
default selection. Page mode displays the report the way it will print.

vew -| @ 551 88| 9
|j|__ Quick Display mode
=] Page mode
[|[5) Draft mode
[ PDF mode

|7 Left Panel

:|T Status Bar
[B5 Fold/unfokd
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Web Intelligence Objects (Webl) and Business Objects InfoView

View an Existing Report

10. If User Prompt Input changes are needed, click the Advanced button to display the User
Prompt Input dialog and make the necessary changes.

Note: The Advanced button only will be visible if the User Prompt Input button is selected on the
lower left-hand side of the report window.

SAP BUSINESSOBJECTS INFOVIEW

&% Home | Document List | Open ~ | Send To ~ | Dashboards ~

Web Intelligence - 7328_GL Running Balance Report_562

# Document ~ View ~ | (5] 25 [ 33 | @ v I1 b

User Prompt Input
[ﬂ Advanced | =~ Run

SAMPLE REPORT: This report is provide
jon your requirements and your data. Mak

Enter GL Account Number (use % fqg
[1252400%

Enter value(s) for GL Account Status | GL Account Actuals Running Ba

[2009
GL Account Number

155255543401
1E8740CEEEDT
17R2400EEE09

1262400HHHO3

1£52400LLL41
User Prompt
Input Button
R m | NP )
=1 Tl S l [£) Report1 ‘

Be certain to “Run the query” again and make certain the report is reflecting the information you
require. If not, “tweak” the query until it works the way you want.
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Web Intelligence Objects (Webl) and Business Objects InfoView

It also is possible to select Modify and Run a Query. This choice brings the user into
development mode and provides many additional options including the ability to save to one’s
computer or InfoView folders.

Modify an Existing Report

1. Click the InfoView Home tab.

2. Right-click the copied Running Balance Report in your “My Favorites” Folder and select

Modify from the shortcut menu.
If the following Java Security Alert displays, click No.

Be Careful! Since we know we are accessing InfoView and Web Intelligence from a server on
our campus that is protected and monitored, you can select “No”. If you see this prompt under
different circumstances, click “Yes” unless you determine the site is known and safe. Otherwise,
you could expose the computer to security threats.

Warning - Security lﬁ
Java has discovered application components that could (@]
indicate a security concern. E 3

Name: Java_Report_Panel

Block potentially unsafe components from being run? (recommended)

More Information...

(7§ ]  The appiication contains both signed and unsigned code.
e/ Contact the application vendor to ensure that it has not been tampered with,

\ —

3. This Prompt dialog box looks pretty similar to the one displayed when “View” is chosen from the

shortcut menu:

] __
T i

Select or type the prompt values for each prompt below.

V' |Enter GL Account Number (use % for wildcard match): 1562400%

V' Entervalue(s) for GL Account Status Fiscal Year: 2009

Refresh values i Enter GL Account Number (use % for wildcard...

K 4 [ 110040088802, 1250111KKKDS _ w [P M [~ (oo
GL Account Number [ —
110040088802 A r( J
110040088805
1100400EEEQL
110043488802
1100434EEE0L
1100434EEE08
1101311EEE0L
1101312EEE0L
110140088800 -
Last Refresh Date: March 25, 2011 9:24:57 AM ..

arch pattern @ -

< Refresh Data Cancel |
= =1

4. Refresh the Data. Then, review all prompt information and make changes, as necessary to

perform your desired query. Be certain to “test” the query to make certain the report actually is
getting the information you require. If not, “tweak” the report until it works the way you want.

web intelligence objects and infoview 9 R. Sibulkin,

Technical Training & Support
Worcester State University



Web Intelligence Objects (Webl) and Business Objects InfoView

Modify an Existing Report
5. Click OK to the Document Auto save and Recovery Alert.

The Report Opens displaying the results on which the data was queried.

| 6L Running Balance Report

DE - & E- |6 Edthuery} 3 Edit Report| & Refresh Data =X | [ Track T M| W | 6| % | Q orin &9
H Save as... Y -|E[& = |- i1100% v || Page M 4
;|| Savetomycomputeras » Exicel

= | PDF

Data | Templates | Map | Propei

 Data v
.r: ‘GL Running Balance Rebort CSV (with options)... PLE REPORT: This report is provided as a template and is meant as a reference for your report development. This report's fitness for use m:
S5 o1 GuL A((gnu:taN:fn::O N your requirements and your data. Make any formatting and design changes as needed and verify the report logic and output in your environme]

# GL Account Tag
- # GL Classification
4 GL Summary Calendar Month
# GL Summary Fiscal Year
2 GL Summary GL Account
"
. .GE Sumimayy, Fiscal Y eseMonthyNumbes GL Summary  |Fiscal Year Month (GL Summary GLAccount |Credit (Opening
e ounent Yearhalonce GL Account Number Fiscal Year Number (Calendar Month Debit Amount _[Amount Balance

GL Account Credit Amount

GL Account Actuals Running Balance Report

i GE Aceoint Debit Arount 150040048401 2009 12 June, 2009 $9.846.94 $0.00

i Opening Balance, 15°2400EEE01 2009 4 October, 2008 $12,191.00 $0.00
“ Running Balance

w Running Balance with Opening Balance 157 2400EEE09 2009 1 July, 2008 $147,755.54 $0.00

. 5 December, 2008 $900.00 $0.00

7 January, 2009 $560.00 $0.00

8 February, 2009 $10,932.41 $0.00

9 March, 2009 $3,500.00 $0.00

6. Click the Save button (looks like a floppy disk) and choose Save As.

When Save As is selected, a copy of the report can be saved to one of the folders under
My Favorites in the Infoview Home space (e.g. My Reports).

|£| Save Document

._’irFroidersri & Categories

LSS @ Home

=% My Favorites
({7 ~Webintelligence 7328_GL Ru... 74 KB rsibulkin
CF - Practice

Title Size Owner Description

f
p

&-(] Public Folders

Name: 7328_GL Running Balance Repord

oK ][ Close ] [ Help ]
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Web Intelligence Objects (Webl) and Business Objects InfoView

Now that you have been provided with some basic information about using Web Intelligence (Webl)
objects and a sample report, let’s take a closer look at some additional features and modifications that
can be done using an existing Sample Student Report.

Copy Sample Student Reports into Your InfoView My Favorites Folder

1. If you do not already have Webl InfoView open, Log On to Infoview (which also will be referred to as
Webl—short for Web Intelligence, since InfoView is a Web Intelligence object), and expand the
Public Folders by clicking the + sign to the left of the folder name.

Keep in mind that the only “folders” you see are ones to which you have been provided access.

2. In order to create a separate folder in which to store the modified sample Student reports you plan to
use, right-click on your My Favorites folder and select New followed by Folder from the displayed
shortcut menu.

3. Inthe “Enter a new folder name” box, type the hame you want to assign to the new “My Favorites”
subfolder (e.g. ST Practice or ST Universe Samples — Copy. Make sure to differentiate the name
from the original folder that is going to be copied, so you can tell them apart) and click OK.

4. Under Public Folders, click the + sign to expand Datatel Sample Reports Release 1.2.

5. In order to modify an existing report instead of starting from scratch, under Public Folders, Datatel
Sample Reports -1.2, right-click the ST Universe Samples subfolder, select Organize, and left-click
Copy.

6. In order to place copies of the ST Universe Samples reports in the subfolder you created, under
My Favorites, select the ST-Practice folder (or other folder created to store “your’copied Webl
Reports) and choose Organize followed by Paste.

The copied folder/reports should display beneath your My Favorites folder.

SAP BUSINESSOBJECTS INFOVIEW
&7 Home | Document List | Open ~ | Send To - | Dashboards ~
= @ | = | New v Add -~ | Organize v | Actions ~
E-All Title * Last Ri
& My Favorites ¥ Average Course Grade by Term, Courses an
~Webintelligence What grades did students get for their cours
) CF - Practice ¥ Enrollment Charts
My Reports What are the most popular courses? Progral
& ST - Practice Ver 1.2 ¥ Total Credits for Students by Enrollment
=] ST Universe Samples - Copy How many credit hours are registered by ea
Applications and Applicants Sam
& mbox
[ public Folders

7. Expand the ST folder in which you pasted the copied Sample Reports and click on the Enroliment
Samples folder.

The “Total Credits for Students by Enroliment” Sample report is going to be used for the
remaining examples.
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Modify the “Total Credits for Student Enroliment” Sample Student Report

1. Right-click the “Total Credit for Student Enroliment” Sample Student Report and select View from
the shortcut menu that displays.

The Student Enroliment subfolder should be located in the copied ST Universe Samples folder.

The report displays with its default settings.

k. Prompts X

3
I Reply to prompts before running the query

Enter value(s) for Enroliment Term: 2001/52;200

Enter value(s) for Enroliment Term:
2001/82

2007/F1

2006SP

Enroliment Term 2004/FA

00/FA 2002/52

00/81 2003/52

00/S2

00/SP

01/FA

01/81

01/52 o
July 18, 2011 8:46:14 AN GMT-04:00

2) More Information

Refresh Values ¥2

‘A||V‘

[TRY

|43 -

I Run Query I‘ Cancel ‘

The displayed prompt says “Enter value(s) for Enroliment Term ...” and lists the terms specified
under “Enter value(s) for Enroliment Term:”on the right-hand side of the Prompts screen.

2. To modify the existing Enrollment terms to terms you want to query, highlight the unwanted
terms and click the “<” key to move the selected terms off the right-hand column.

The <Shift + Click> or <Ctrl + Click> methods work well for selecting the listed items.

<Shift+Click> works to select items next to one another.
The <Ctrl +Click> works to select items that are not next to one another.

a. Click the first listed term you wish to remove to highlight it (e.g. 2001/S2).

b. Press the <Shift> key.

c. While holding the <Shift> key, click the last listed enrollment term you wish to remove.
All listed terms from the first to the last selected should be highlighted.

Use <Citrl + Click> to select listed items that are not next to one another.
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Web Intelligence Objects (Webl) and Business Objects InfoView

Modify the “Total Credits for Student Enroliment” Sample Student Report

3. Click the Refresh Values button to refresh the data.

Prompts X

Reply to prompts before running the query.

b4  Enter value(s) for Enroliment Term: 14/51

Enter value(s) for Enroliment Term:

] E] 1151

Refresh Values %2 ‘Z]

Enroliment Term
1182

July 18, 2011 1:16:01 PM GMT-04:00

[1s2 & -

@ Currently-selected values in fistbox

™ |

I Run Query ]| Cancel [

4. Enter the desired terms in the Search box (to the left of the binoculars). In the example above,
11/S1 (2011/Summer 1) already was entered. Search for and Enter 11/S1 and 11/S2 or other
desired terms.

5. Click the Run Query button.

Click OK if the Document Auto save and Recovery prompt displays.

The completed report displays.

¢ Home | Document List | Open ~ | Send To ~ | Dashboards ~ Help | Preferences | About | Log OY
eb Intelligence - Total Credits for Students by Enroliment aF
b Document ~ view « | [ 25| 44| @ W[t Jae e m Edit | & RefreshData | [ Track 1 O | % | 85| Q)
ser Prompt input 2
1) Advanced | & Run [SAMPLE REPORT: This report is provided as a femplate and is meant as a reference for your report development. This L
report's fitness for use may vary depending on your requirements and your data. Make any formatting and design changes 5
jaeruaen s} osCerodmn et s needed and verify the report logic and output in your envi before use.

1/51;11/52

Total Credits for Student by Enroliment for 11/81, 11/82
11181

Enroliment Enroliment Registered
Department1  |Enrolled Current Course
Desc Course Name _|Status Desc __[Credits

HI111 New 3

History/Political
0012345 Science

1 Lancer, Joseph Sum: 3
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Familiarize Yourself with the InfoView Report Window.

The Webl InfoView Student Report is displayed in “Viewing” mode in the graphic below. It's easy to tell
because the “Edit” button (on the right) is not depressed (highlighted/blue).

From Left to Right there are several buttons and drop-down menus.

Home | Document List | Open ~ | Send To ~ | Dashboards - Help | Preferences | About | Log O
eb Intelligence - Total Credits for Students by Enroliment [+

b Document + view ~ | [ 15| 43| 9 [lo0% |~ [ Jas»m Edit | & Refresh Data | [1 Track | % 88| Q

ser Prompt Input

|71 Advanced | & Run

Teportis provided as a tem as a reference for your report development. This
& may vary depending on you our data. Mak ign char
rt logic and outy

e any formatting and design changes

Inter value(s) for Enroliment Term:
151,11/52

Total Credits for Student by Enroliment for 11/81, 11/S2
11/81

[Enroliment Enroliment Registered
Department1  (Enrolled (Current (Course
IDesc. ICourse Name | Status Desc (Credits.

HI-111 New 3

History/Political

Science

1 Lancer, Joseph Sum 3

The Document drop-down menu, allows the document object to be saved to your computer in an
Excel, CSV, or PDF format once the query report is run. Save to my computer only saves a
“snapshot” of the data from when the query was run. Database data gets refreshed each night.

The View menu provides several options for viewing the report. Quick Display mode is the default
selection, but Page mode displays the report the way it will print.

The Zoom menu can be used to increase or decrease the size of the text you are viewing on your
computer monitor without changing the size of the text in the report.

The Page Navigation area on the toolbar allows the user to move through the report pages one-by-
one or by going to the first or last page of the report. If the report is going to be printed, it helps to
switch to Page mode to view the report the way it will print.

The Edit button allows the user to switch from “View” to “Edit” mode in order to modify the report
document using the Web Intelligence InfoView report panel.

' Document ~ View ~ | [ e The buttons on the lower left-hand side of the report viewing
window provide information about the active report.
User Prompt Input
g o e Navigation Map button display sections/items in the
Fi Advanced | ' Run The Navigation Map button display sections/it th
Enter value report. Click the + sign(s) to expand and display section/item
s forEnripent Foime names. Then, click the section/items you want to view to move
[1sti11/s2 to selected areas of the report.
The User Prompt button displays the Prompt screen. Click its
Advanced button to view the Prompt screen or to Run the
Navigation Map Report query.
Usgr Prompt Info Find lets the user search the report for specified “text”.
Input Controls e The Refresh Data button queries the database and obtains
- its most current data. The report displays results based on the
i E *] 34—search information contained in the database at the time the query
was run.
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Viewing the report in Page mode displays the report the way it will be printed.
Once the report is viewed, it is possible to see if modifications to the report are necessary
to obtain proper page placement.

View the Sample Student Report in Page mode.

1.

If the “Total Credits for Student Enrollment Sample Report” is not Open, Log On to Webl
Reporting InfoView to locate the Sample Report you saved in your My Favorites subfolder
(e.g. My Reports or ST Universe Samples — Copy).

Right-click the “Total Credit for Student Enroliment” Sample Student Report and select View from

the shortcut menu that displays. Refresh the Values and Run the Query.

Search title ~

Title * Last Run
¥ 7328_GL Running Balance Report

|7 & ©  New ~ Add ~ Organize ~ Actions ~
= All
&[5 My Favorites
2 ~Webintelligence
&[] CF - Practice
My Reports

B2 ST - Practice Ver 1.2 Total Credits for Students by Enroliment - July 20 2011
#[0 ST Universe Samg Properties

“ = Inbox ¥  Total Credits for Students by Enrollment - July 2011 Categories \

[ 1 public Folders How many credit hours are registered by each student? View
Modify
Schedule
History

¥  7328_GL Running Balance Report_562

New »
Add »

Organize »

The report should display.

¢ Home | Document List | Open ~ | Send To v | Dashboards ~ Help | Preferences | About | Log O
eb Intelligence - Total Credits for Students by Enroliment
b/ Document ~ View - | [ 25| 33 | 9 - e b M Edit | & RefreshData | [ Track i % |e8 | ¢
ser Prompt Input
1] Advanced | & Run [SAMPLE REPORT: This reportis provided as a template and is meant as a reference for your report development, This L
Ireport's fitness for use may vary depending on your requirements and your data. Make any formatting and design changes 3
jnter valae(s) for Enroliment Term: s needed and verify the report logic and output in your environment before use.
1/51;11/52
Total Credits for Student by Enroliment for 11/81, 11/82
11/81
Enroliment Enroliment Registered
Department 1 Enrolled \Current (Course
Desc Course Name _|Status Desc (Credits
History/Political
D012345° Science HI-111
4 Lancer, Joseph Sum: 3
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View the Sample Student Report in Page mode.

3. From the View drop-down menu, select Page mode.

SAMPLE REPORT: This report is provided as a template and is meant as a reference for your report developmfnt. This
report's fitness for use may vary depending on your requi and your data. Make any formatting and desgn chang¢
las needed and verify the report logic and output in your environment before use.

Total Credits for Student by Enrollment for 11/81, 11/82
11/81

Enroliment Enroliment Registered
Department 1 Enrolled Current Course
Desc Course Name |Status Desc Credits

History/Political
M—— 0 Science HI-111

Sum: 3

Notice that the green Sample Report description text box gets cut off at the end.
We’'ll use this as an example of how to modify a text box or other similar object.

4. Click the Go to Next Index arrow to move to Page 2 of the report.

/1+ﬂn

[ Go to next index ]

Only the remaining small piece of the green Sample Report text box displays. Therefore, it will be
necessary to modify the size of the text box in order to fit it on one page.

BeS

5. Click the left Go to previous blue arrow to move back to page 1 of the report.

Use the Edit button and Modify the “Total Credits for Student Enroliment” Sample Student Report

1. With the Total Credits for Student Enroliment report open, click the Edit button.

Warning - Security 5 ==

Java has discovered application components that could mi
indicate a security concern. |

Name: Java_Report_Panel

Block potentially unsafe components from being run? (recommended)

More Information...

F ] 7] The application contains both signed and unsigned code.
. Contact the application vendor to ensure that it has not been tampered with.

2. Since this report is being accessed from a secure WSU site, when the Java warning displays,
click No.
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¢ In Edit mode, four tabs appear on the left-hand side of the report panel.

e “The Data tab displays Web Intelligence dimension and detail objects that can be used in the report in
blue. A dimension object represents data that provides the basis for analysis in a report. Dimension
objects typically retrieve character-type data (e.g. student names, enrolled course names)

A detail object provides descriptive data about a dimension. A detail is always attached to the
dimension for which it provides additional information (e.g. [Student ID] is a detail object that is
associated with [Person Full Name])

A measure object retrieves numeric data that is the result of calculations on data in the database.
For example, [Revenue] is the calculation of the number of items sold multiplied by item price.
Measure objects are often located in a Measures class. Measure objects appear in gold in the Web
Intelligence query panel”.

g Total Credits for Students by Enrollment - J

' Enrolled Course Level Desc

' Enrolled Course Name

' Enrollment Current Status Desc

' Enrollment Department 1 Desc

' Enrollment Term

' Person Full Name

' Person Preferred Name

' StudentID
Input Enrollment Term
Registered Course Credits
Registered Course Credits - Distinct

Use the Edit button and Modify the “Total Credits for Student Enroliment” Sample Student Report

The sample student report switches to “Edit” mode.

Total Credits for Students by Enrolilment - July 20 2011 LR
M & - || # | B~ | 5 edit Query| [ Edit Report T Refresh Data =X | [22 Track T | W | %8| 7| Q oril o8 | @
Lk | g | A | CE|4l - - 100% v | Page M 41 DM

Arial MG vBI!Av’?av.

Data | Templates | Map | Properties | Input Cont..

A

Data 2
=-9! Total Credits for Students by Enrollment - July 20 2011

Enrolled Course Level Desc

! Enrolled Course Name

' Enrollment Current Status Desc

¢ Enoliment Departmentd. Desc Total Credits for Student by Enroliment for 11/81, 11/S2
Enroliment Term

! Person Full Name

! Person Preferred Name ausy 000

! Student ID

Input Enrollment Term Enroliment Enroliment Registered

Registered Course Credits Depnmmm 1 |Enrolled Current Course

Registered Course Credits - Distinct Student ID Course Name |Status Desc [Credits
111 N

|[SAMPLE REPORT: This reportis provided as a template and Is meant as a for your report Thi
report's fitness for use may vary depending on your requirements and your data. Make any formatting and design changes
t

ient before use.

HlstcrylPoI\ncal
0012345 Science

Lancer, Joseph Sum: 3

3. Click the green SAMPLE REPORT text box. A border surrounds the text box to show the box is
selected Other objects can be selected this way, also.
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Properties for the selected item display. Click the + sign to the left of bolded categories to
view settings and areas that can be modified.

Data | Templates
Properties
=8| =

=l General

e
A @V
Ty Ta

Map~ Properties

Input Cont..

ol

Text

Display

Autofit width
Width

Autofit height
Height

Read cell content as

=I Appearance

+)

Text Format
Background color
Background image

Display

SAMPLE REPORT: T...

[] Yes
689 px
[7] Yes
40 px
Text

[Arial,8,Bold]
1206, 255, 206

m

5. Click inside the Autofit width box to activate “Yes”

As you will see, the box becomes much too narrow.

4. On the left side of the screen, click the Properties tab.

Use the Edit button and Modify the “Total Credits for Student Enroliment” Sample Student Report

6. Click Undo or Point your mouse pointer to the right-hand border of the text box until the pointer
turns into a line with two small black arrows—one pointing left and the other pointing right. Drag

the right border to the text box width you think will be right.

7. Make certain the header remains on Page 1. If not, click Undo or readjust the text box border.

Click the Switch Page/Quick Display button to view the result of the change.

Click the Switch/Page/Quick Display button to toggle the Page view On and Off.

T

= .? View Structure
Is

witch Page/Quick Display | <

web intelligence objects and infoview
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Web Intelligence Objects (Webl) and Business Objects InfoView

Use the Edit button and Modify the “Total Credits for Student Enroliment” Sample Student Report

8. If the selected text box is too wide or doesn’t display properly, click the Switch Page/Quick Display
button again to turn off the Page View display. Then, drag the border until you get the desired

result.

Of course, this particular text box could be deleted, as well, if you don’t want it on the report. .

9. Make certain you are on Page 1 in Edit mode and click to select the Total Credits for Student
Enrollment 11/S! 11/S2 text header box.

10. With the header box selected, click the Properties tab and activate the “Repeat on every new
page” Yes. Then, scroll through the pages of the report to see the result.

Data | Templates | Map~ Properties | Input Cont..

: Properties q
g2 4 (= =3 =l
Underline [T Yes -
Strikethrough ] Yes
Text color MO0 00
Wrap text V] Yes

Vertical text alignment Bottom
Horizontal text alignment  Left
Background color =
Background image
Borders
=) Page layout
[l Relative Position 91 px;:84 px 2
Repeat on every new page
Sets the cell to repeat on every new page.

m

11. Return to page 1 of the report.

12. Click the Data tab to bring it in front of other tabs and return it to the default tab position.

13. Remain in Edit Mode.

R. Sibulkin,
Technical Training & Support
Worcester State University
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o As defined by SAP, “A ‘section’ breaks up the data into multiple free-standing cells called
section headers. Each section header contains one value for a dimension (object), with a block of
data that corresponds to the dimension value.” (SAP) p189

Use the Data Map to View Sections of a Report.

1. While in Edit mode, click the Map tab to view existing sections of the report.

A Data Templates Mép Properties | Input Cont..
: Map a
Map | Filters | Structure | Input controls

=l Total Credits for Students by Enroliment - July 20 201
== Reportl
- @ 11751

* 11/S2

This report has two sections.

2. Since only Section 1 is showing on the first page of the report, on the Map tab click 11/S2.
This should move the cursor to the 11/S2 section of the report.

3. Ifyou like the changes you made to the report and want to keep them, click the drop-down arrow on
the Save button, choose Save As, and Save the modified report to the My Reports folder or other

desired Webl InfoView folder. Click OK.

Remember to change the name, slightly, from the original sample report in order to keep the original
sample report intact.

- > -
Total Credits for Students by Enj | Save Document =
MIE ~| &3 + | (5 Edi
|| 3 it
'DJ aﬁ E L’J Q Folders| & Categories
Save as... = \:‘gjor’\j‘; Eatiiies Title Size Owner Description
+-{ 7] ~Webintelligence 7328_GL Ru... 69 KB rsibulkin
Save to my computeras » ¥ CF - Practice 7328_GL Ru... 74 KB rsibulkin
- - i Total Credit... rsibulkin How many ...
(=4, 1 ST - Practice Ver1.2 Total Credit. ibulki ¥
= ST Universe Sample SRSl SSDETR I
&2} Applications an
4 Enrollment Sam
o Public Folders

< (1] »

Name: |Total Credits for Students by Enrollment - July 20 2011

oK ] { Cancel ] [ Help J

4. Remain in Edit View to continue modifying the report or Close the report and Log Out if you are
finished.
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e |tis necessary to select report data prior to adding formatting in order for the formatting to be applied.

e A break divides the data up within one block. One column contains the values for a dimension, detail,
or measure, which are repeated for each other row of values in the block.

e Additional objects can be added to a report by dragging them from the Data tab.
They can be removed from a report by dragging their column header off to the Data tab area.
Modify Formatting to Columns of Report Data
1. If the “Total Credits for Student Enroliment Sample Report” is not open, Log On to Webl
Reporting InfoView to locate the Sample Report you saved in your My Favorites subfolder

(e.g. My Reports or ST Universe Samples — Copy).

2. Right-click the Total Credits for Student Enrollment Sample Report name and select Modify from
the shortcut menu. This will display the report in “Edit” mode.

3. Click on a column header in the open Sample Report.

Notice that only the header is selected, not its corresponding data.

4. Click on a Student ID number.
All student ID numbers should be selected.
5. Click the Bold button on the formatting toolbar.

All student ID numbers should be bolded.

Duplicate the Report 1 Tab.
1. Right-click the Report 1 tab and select Duplicate Report from the shortcut menu.
A duplicate report displays with the name “Report 1 (1) on its tab.

2. Double-click the duplicated Report 1 (1) tab and Rename it to My Copy (or other desired name).
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Duplicate the Report 1 Tab.

3.

With the duplicate report active, select Save As and save a copy of the report to My Reports (or
another desired My Favorites subfolder) with the name Total Credits for Students by Enrollment —
My Practice..

The saved duplicate report will provide a backup to use for practice and keep the initial
report intact.

Total Credits for Students by En| [[cseoocre SN
rk ‘.DJ % ‘5_3 L?ﬁ [j b |:)"J Edit Q Folders & Categories 7;7 [

|E \){7‘ “Home

Save as, G My Favorit Title Size Owner Description
vee = ty Favorites
| 1 ® ~Webintelligence 7328_GL Ru... 69 KB
Save to my computer as » o CF - Practice 7328_GL Ru... 74 KB -
‘ 5 W Veris Total Credit... 443 KB How many ...
- Practice Ver L.

4 Public Folders Total Credit... 445 KB ||

Name: | Total Credits for Students by Enrollment - My Practicel Advanced * |

ok | [ close | [ Hep |

Keep the saved “Practice” report open.
On the Reporting toolbar, click the Show/Hide Formula Toolbar button.

Notice the formula that was entered into this sample report in order to display the Student’s ID
in the cell.

& X Fistudentin) |

Click the Student’s Name and view the entered formula.

Modify the Student ID Break Properties

7.

With the duplicate My Copy tab (or Report 1 (1)) active, click the bolded Student ID number.

The “break” button on the Reporting toolbar is highlighted, which means a “break” was added to
divide the Student ID data up within the block.

Under the Student ID column header, click the student number of the first student listed.

All student ID numbers should be selected. In addition, notice that the data is divided within one cell.

£l

On the Report toolbar, click the break L= button.

The break is removed and only student ID humbers display.

10. Click the Undo button to return the cell break.
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e The dimension, detail, and

measure objects that appear on the report’s Data tab are available to be

placed on a report because a query was run to add the desired objects to the report document.

Add the Enrollment Term Ob

ject onto the Total Credits for Students by Enroliment Report

=1--w! Total Credits for Students by Enroliment - J
; Enrolled Course Level Desc

Enrolled Course Name

Enrollment Current Status Desc

Enrollment Department 1 Desc

Enrollment Term

Person Full Name

Person Preferred Name

Student ID

i Input Enrollment Term

w Registered Course Credits

w Registered Course Credits - Distinct

1. Locate the Enrollment Term object on the Data tab and drag it in-between the Enroliment

Current Status Desc and

the Registered Course Credits columns. Refresh the data and View

the report, and Save the changes.

Make sure to line up the object so the blue bar lines up like the one in the graphic below.
Although the object was part of the report’s query filter, it also is visible on the report, now.

or Student by Enroliment for 11/81, 11/S2
Enroliment Enroliment E
Department 1 Enrolled Current ourse
Desc Course Name |Status Desc tts .
Education ED-925 .
Dro here to insert a celll

Enroliment Enroliment Registered
Department 1 Enrolled Current Course
Desc Course Name |Status Desc Credits
History/Political
Science HI-918 3

Sum: 3

To remove the Enroliment Term object column from appearing on the report, drag the column

header off to the left-hand Data tab area. Save the changes to the report.

Since the Enrollment Term object still displays on the Data tab it can be added to the report in

the future.

SAP BUSINESSOBJECTS INFOVIEW

4 Home | Document List | Open ~ | Send To ~ | Dashboards ~

[
SAP BusinessObjects

Help | Preferences | About | Log O

| Total Credits for Students by Enroliment - My Practice

™ & ~| | d0 | B~ | (3 Edit Query| 3 Edit Report

w9 A - |
B 7 U|A -

3
' Refresh Data =X | [T Track T M| W | 46| % | Q orin ol | @ | @

%~ | 1% - | [E) 2 View Structure |
L - <]

=] 100% v || PageM 4|1 (PN

Data | Templates | Map | Properties | Input Cont..
 Data L3
-9 Total Credits for Students by Enrollment - My Practic

4 Enrolled Course Level Desc
~ # Enrolled Course Name
# Enroliment Current Status Desc
4 Enrollment Department 1 Desc
4 Enrollment Term
4 Major Academic Program
~ # Person Full Name
4 Person Preferred Name
4 StudentID
Input Enrollment Term
Registered Course Credits
Registered Course Credits - Distinct

]

[SAMPLE REPORT: This report is provided as a template and is meant as a reference for your report
levelopment. This report's fitness for use may vary depending on your requirements and your data. Make
ny formatting and design changes as needed and verify the report logic and output in your environment
lbefore use.

Total Credits for Student by Enroliment for 11/81, 11/82
11/81

Enroliment
Department 1
Desc

History/Political

Registered

Enroliment
Enrolled (Current \Course
(Course Name | Status Desc

(Credits
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“Two types of filters exist in a Web Intelligence document.

Query filters: These filters are defined on the query. The data returned is retrieved from the data source
(Colleague UlWeb) and returned to the Web Intelligence document.

Report filter: These filters limit the values displayed on reports, tables, charts, and sections within the
report document and don’t modify the data retrieved from the data source. They hide values at the report
level”. (SAP) p.104

Many types of queries can be created using Web Intelligence. I'll explain how to make some basic
changes to the query below.

Edit the Report Query
1. With your Total Credits for Students by Enroliment — My Practice. Sample report open in Modify
(Edit) view, click the Data tab and notice that the Enroliment Term object still is available for use on

the report, if desired. That is because Enrollment Term is part of the report filter.

2. Click the Edit Query button.

The Data tab displays many additional dimension, detail, and measure objects that can be included in
the report. Expand folders to view additional objects.

Existing report dimension, detail, and measure objects included in the query appear at the top
of the Result Objects area. Query filters appear at the bottom.

3. Under the Student Program Majors folder on the Data tab, drag the major academic program
object to the right of the Enrollment Department Description object in the Result Objects panel.

SAP BUSINESSOBJECTS INFOVIEW sws..smmoqg

€7 Home | Document List | Open - | Send To ~ | Dashboards ~ Help | Preferences | About | Log Out

Total Credits for Students by Enroliment - July 20 2011 F X
BN | 5| B~ | (7] Edit Query [ Edit Report = Run Query X | @) | @+
i i (5 Add Query | | E

Barall| Properties Result Objects I 1 X R
i - StudentID |  Person Preferred Name | # Enrollment Departmentlts{ I teret Course Cratits | Enrolled Course Level Desc
R Major Academic Program
Registered Course Credits - Distinct |  Enrollment Current Status Des Pefon Full Name | # Enroliment Term | # Enrolled Course Name
Academic Program Locations
Tests and Non Course Activities
Student Cohort Groups
Student Programs
All Student Programs
* Student Program Majors
Student Programs Id
Pos
Major Academic Level
Major Academic Level Desc
Major ID
Major Desc Query Filters || X T
Major Source
Major Student ID Enroliment Term Inlist , |Enter value(s) for Enrollment Term: | @ [iS
Student Program Minors
~ Student Enrollment
Enrolled Academic CreditId
Enrolled Course Academic Level

The Major Academic Program object should display in place of the cursor at the selected location.

4. Run the query.

The Major Academic Program object now appears on the Report Data tab with other existing
objects and can be added and viewed on the report, if desired.

5. If you are happy with the result, Save the report. If not, click Undo.
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Close the Report Document and Log Out

1. |If you are finished with the open report document, click the Close document box (See below) to
close the Sample Report.

SAP BusinessObjects’

ces | About | Log Out

2. If you are finished using Webl InfoView, click Log Out in the upper right-hand corner of the SAP
Business Objects window.

3. If the SAP Business Objects Log On to InfoView screen displays, select File followed by Exit to close
the browser window.
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